rrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrr

Getting started with
Excel

we LONDON A

° 0\
/ * A

N~ U

Trust for London

Tackling poverty and inequality



» superhighways
% eermnig %

harnessing technology for community benefit

Contents
WOTrKING With EXCEl ....uiieeeeeiiiiieeiiiieceeitiicessenaeessenaseesenasseseennsssseennssssesnsssssesnsssssesnsssssesnsssssesnsssssennnsnssennn 3
1. Understanding the RIDDON ......oeiiii it e e e e e e e et ra e e e e sabae e e e nbaeeeennees 3
B CT-Y w1 oY= o T=Y I TSRS 3
3. COrreCtiNg MISTAKES .o eeiei e e e e et e e e st e e e e e e e e e s bee e e e nbee e e e nabaeeeenarees 4
4. Different Versions Of EXCEI .....oouei ittt ettt ettt e bt e e sab e e s e e sabeesneeesaneenas 4
VieWing SPreadshEets........ciiiieciiiiiiiceiiiccrreiecerreresesrennseseenas e seenassssesnnsssseensssssesnsssssennsssssennsssssennnsnsnennn 5
D FOIMAT TADS ettt st e b bt e bt e be e sbe e st e et e ereen 5
T N (= T=Y =l o =Y = PP PP PP P PP P PP PP PPPPPPPPPPPPPPPPPPRt 5
P UL {21 2=l o = o1 PPT 6
8. HIdE COIUMINS ..ttt ettt e sttt e st e s bt e e s bt e s bbeesabeesabeeesabeesabeeeaneeesanenesaseeas 6
9. UNNIAE COIUMNS <.ttt ettt et b e bt e s bt e sbe e sat e et e et e e sbeesbeesaeesatesabeeabeebeennees 7
10. RESIZE COIUMINS ...ttt et sh e st st st b e b e bt e s bt e sae e eateeabe e beesbeesaeesaeenane 7
11. L AT =] o 1= 8
e T a1y TV TUT N - | - TS 9
12. Yo ) gl T=d S Y= LT L= ) SR 9
13. QUICK COUNT VIBW ..ttt ettt st st e b e bt e s bt e s he e sae e et e e sbeesheesaeesabeeabeebeenbeennees 9
14. SOMTING (IMUILI-IEVEI) e et e ettt e e e et e e e e ebte e e e s bteeeeestaeeesstaeaessraeaeennes 10
USING FOIMUIG.... ettt rrra e s rerae e s st sa e s s e nas e sssnasssseenssssssensssssesnsssssasnsssssssnssnsnssnssssnenns 11
15. AUTO SUIM Lottt a e s s aa b e s bbb e e e s bbb e e e s bbb s e e s bbb e e e sbbas e e saaabaeesas 11
16. (000 o1V T oY= (o o o U1 F- TSROt 11
17. FANY ] - T USSR 12
18. Adding a simple MUIIPHCATION ....iiiieee e e e et e e e e rar e e e e ara e e e e areeeeas 12
T 01 1T - 13
Nty

LAY



hamessing technology for community benefit

qu erhighways
‘ Pemig Yy

Working with Excel

1. Understanding the Ribbon

It really helps to get to grips with the Excel terminology as it makes like a lot easier to find things &
understand instructions when using the Microsoft Excel help feature or the internet for help.

Quick
Access Command
toolbar Tabs buttons

‘ ¢ @ ® ®
HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW | ® |

% e I Al = — =- 5 o
7 calib -1 A A== % |EWepTet General - 4 4
B - alibri | = |7 =¢ Wrap enera .. B =
Pate o | B T U-|H-|D-A-===|=%=|EMergetiCenter - | $ - % » |8 5 | Conditional Formatas Cel
Formatting~ Table~ Styles~
Clipboard Font F] Alignment ? P Number ] Styles
Groups Dialog launchers

The Ribbon is made up of five basic components: the Quick Access Toolbar, tabs, groups, command buttons,

and dialog launchers.

e The Quick Access Toolbar is essentially a customizable toolbar to which you can add commands that
you use most frequently.

e Tabs contain groups of commands that are loosely related to core tasks. It helps to think of each tab as
a category.

e Groups contain sets of commands that fall under the umbrella of that tab’s core task. Each group
contains buttons, which you click to activate the command you want to use.

e Dialog launchers are activated by clicking the small arrow located in the lower-right corner of certain
groups. Clicking any dialog launcher activates a dialog box containing all the commands available for a
given group.

e Command buttons when clicked launch a macro which perform a specified action in Excel.

2. Getting help

If you can’t remember where to find a function in Excel, use the search function at the top to get assistance.

AutoSave E':é'. ") - Music Mentors data with notes.xlsx 82 - Saved ,O Pivot‘ X
File Home Insert Page Layout Formulas Data Review View I Best Action
AB e Je Alain Prost PivotTable
Actions
ﬁ PivotChart >
A B C E
1 - Prison - Date of birth - Date registered - M [ Recommended PivotTables
2 Wolfgang Puck HMP Pentonville 11/10/1982 20/01/2002 Bass
3 Julie Walters HMP Bronzefield 20/09/1973 08/02/2012 Bass Get Help on
4 Margaret Atwood HMP Bronzefield 18/09/1963 07/06/2015 Drur “Pivot"
5 Usain Bolt HMP Manchester 21/07/1994 05/05/2014 Drur ® 10 results >
6 HMP Manchester 14/06/1960 05/04/2003 Guit;
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3. Correcting mistakes

Microsoft Excel tracks all the changes you make to a file, if you make a mistake (or two!) you can step
yourself backwards through the changes you made to reverse anything you did wrong.

AutoSave Sy Excel for Sorting & Analysing.docx 88 - Saved

1.Click on Undo Resize Object
arrow to go back a Typing in Text Box " If you realise you made a mistake, use the Undo button to revert”

step. You can
continue to step

¢ Spelling Change
Typing in Text Box s removed will be displayed in a window."

Typing
kbaCk multiple times. Typing in Text Box "The number or duplicted"
: Typing
. . Typing in Text Box "5. A"
Navigation Move Object
Move Object

Search document Paste
wColor
Headings Pages ffabf

4. Different Versions of Excel

There are several different versions of Microsoft Excel, be aware that different versions offer different
features and existing features might be accessed via different means.

These different versions & how they look on a laptop versus a PC means that the screen prints in this
document might not always look exactly the same as the screen in front of you. But the features will be
there so look for the icons which remain consistent or use the search feature to find them.

Microsoft 365

The Business Premium Licence is donated (10 licences per registered charity) and comes with the Microsoft
office suite, including Excel, to download.

Microsoft Office 2016 & later

Previously you could buy a discounted licence if you are a registered charity from Charity Digital for £33 for
Microsoft Office 2019. These products are no longer available, you would need to pay full price for a local
standalone desk top option.

Microsoft licencing is often included on a 2 year open licence which means you get upgrades during this
period, so if using an older version, check before buying anything in case you are eligible for an upgrade
rather than paying for a new product.

Al
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Viewing Spreadsheets
Working with workbooks with large amount of data in each sheet can be very unwieldly. Before starting it’s
worth getting your view sorted out so that you can easily move around between worksheets.

5. Format tabs

26| Insert... 18296 04/05/1999 Guitar 11
27 | ER Delete 30795 17/08/1998 35
28 | Rename 21745 07/03/2011 11
2 Move or Copy... 23783 Guiiar bass 7
30 - 23789 7
i View Code . .
31 & 31655 1.Right click on the sheet tab to reveal e
32 7 Protect Sheet... 10
EE] TebColor ¥ formatting options: Rename, Move & Tab colour z
34 . 17633 16
| Hide
35| 16751 7O 20T, 15
36 | 25615 21/03/2003 Keyboard 9
She Select Al ShEEtE‘ ervice feedback Sheet 2 Session guidelines ‘ Topics for next Excel session (O] [

6. Freeze panes

Allows you to control areas of the spreadsheet to be fixed as you scroll.

Music Mentors data test - Excel

File Home Insert Page Layout Formulas Data Review Help Q Tell me what you want to do
l:l D I@ ” = Q = E D =1 split [ View Side by Side EE
. . E | =
;... Hid -
Mormal Page Break Page Custom 1CIICk on the View tab Zoom to Mew Arrange Freeze ae Switch
Preview Layout Views Selection  Window es v Windows ~
Workbook Views Show PilsleTial Freeze Panes
gl Keep rows and columns visible while the rest of
E12 - Je . the worksheet scrolls (based on current selection).
2.Click on the arrow on Frecze Top Row
the freeze panes I;I Keep the top row visible while scrolling through
the rest of the worksheet.
A | g I ol command button B Freeze First Column J
h | - Keep the first column visible while scrolling -
1 |Name Prison Welfare session\_ through the rest of the workshest. atregis
2 |Alain Prost HMP Manchester ¥ 22051 37710
3 |Alia Bhatt HMP Holloway N 23625 42622
4 |Andre Agassi HMP Swansea Y ( 3 Select hOW you want 27742 37701

to freeze panes

L J




7. Unfreeze panes

Music Mentors data t

Home Insert Page Layout Formulas Data Review Help 0 Tell me what you want to do
|:| D 1@ = . a = E E Split [T View Side by Side
- = (. Hide
Normal Page Break Page Custom 1.Click on the View tab Zoomto ~ MNew Arrange Freeze
Preview Layout Views Selection Window Panes ~
Waorkbook Views plaleauy Toom Unfreeze Panes
gl Unleck all rows and celumns to scroll

02 - e ¥ through the entire worksheet.

2.Click on the arrow on

Freeze Top Row
the freeze panes I;I Keep the top row visible while scrolling

through the rest of the worksheet.

A B D com mand button Freeze First Column

N _— N Keep the first column visible while ~|
1 |Name Prisan Welfare session a\‘ scrolling through the rest of the worksheet, —]
2 |Alain Prost HMP Manchester |Y | Z2UB1 57716
2 _Alia Bhatt HMP Holloway N 23625 42622
4 |Andre Agassi HMP Swansea  |Y 3. Select Unfreeze 27742 37701
5 |Ben Okri HMP Manchester |Y 36015 42622

) . panes
6 |Boris Becker HMP Bristol Y 26459 42793
\ V4

8. Hide columns

Hiding columns from view can be very useful when working with big spreadsheets so that you only work with
the columns you need.

Insert Page Layout Farmulas Review View Help ¢ Tell me what you want 1
o
¥ cut Calibri -l A A== & & Wrap Text General
ER copy -
Paste = = (] s
I U - = = = = = e = i
- ~ Format Painter - Merge & Center E
Clipboard F] Font [F} Alignment P Murmber
D] . .
1.Highlight the column you want to calibri «|11 - A A CD - o
hide by clicking on the letter at the top B I = {r-A-i-% 0
of the column D = . F
1 L elfare session o6 Cut Ethnicity
2 |Alain Prost HMP Manchester Mr Y 1 E® Copy
3 |Alia Bhatt HMP Holloway  Ms N 1 ly Paste Options:
4 |Andre Agassi HMP Swansea Mr ¥ 1 -
5 |Ben Okri HMP Manchester Mr Y 1 O .
6 |Boris Becker HMP Bristol Mr \ | Pastedpecial..
7 |Dave Robson HMP Pentonville Mr ¥ 1 Insert
& |David Attenborough HMP Bristol Mr L 1 Delete
9 |David Beckham H R kil 1 Clear Contents
10 |Diane Kruger . . .
11| Diego Maradonna  |H 2.Right click with your | ] Eormt Cell..
12 | Dilip Kumar Hl  mouse and select Hide Column Width...
12 | Dilip Kumar H — T Hide
14 |Emma Barnett HMP Bronzefield Mr i3 1 Unhide
15 |[Emmanuel Macron  HMP Swansea Mr Y
A lCnid Blhvimm HIRAD Brnnzoficld Kar k'




9. Unhide Columns
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File Home Insert Page Layout Formulas Data
= Dequasar Q[ 2 E'E —
1. Highlight the columns on either side  fings Zoom 100% Zoomto  New Arrang
. R Selection Window  All
of the hidden column by clicking and .
oom
dragging across the top of the
columns.
A B C D | E | F
1 |Name Prison " Dat Calibri - 111 M LR T + at registration
2 |Aalain Prost HMP Manchester
B T = M-~ - €0 .00 o
3 |Alia Bhatt HMP Holloway = e o
4 |Andre Agassi HMP Swansea p 1419 /1a7s 21/03/2003
5 |Ben Okri HMP Manchester | o Cut 09/09/2016
6 |Boris Becker HMP Bristol By Copy 27/02/2017
7 |Dave Robson HMP Pentonville | | % Paste Options: 21/03/2008
3 |David Attenborough |HMP Bristol | o 17/08/1998
9 |David Beckham HMP Pentonville | 0 31/01/2008
10 | Diane Kruger HMP Bronzefield Paste Special... 21/03/2003
11 | Diego Maradonna HMP Swansea | Insert 04/05/1999
f12' Dilig Kumar HIVIP Bristol ! Delete 23/07/2013
. . ! Clenr Content 23/07/2013
2. Right mouse click and _ ear Contents 17/08/1998
select Unhide | ] Eormat Cells... 19/02/2004
A\ Column Width... 17/08/1998
17 |Fiona Bruce Hide 30/09/1999
12 |Fiona Bruce HMP Holloway Unhide 30/09/1999
19 |Freva Crew HMP Bronzefisld = 04/05/1999
10. Resize columns
e > 2. Hover with the mouse \
between columns. When
A g+ .
the mouse pointer changes
Department  Costs
Marketing 340 drag the column to the
Production 200 width you want or double
4 |58 & click for it to automatically
5 |Legal 140 -
6 resize. )
1. Select the columns you 3
want to resize 8
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11. Wrap text

Worap text allows you to display a long line of text on multiple lines so that it can all fit in one cell.

2. Click on Wrap Text

Insert Page Layout Formulas Review ’ “we What you want to do
s
Cut . s v | = _ .'
- Iy db Cu Lalibo 11 A A T == - EE Wrap Text General - =
1. Select the cell where you A === Merge & Center = =2« % » | %3 g5 Conditional
Formatting ~
want to wrap the text ,
IF1 Alignment IF} Number IF]
Cc1 = ptimism at start (1{bad)-10(good)) Wrap Text
Wrap extra-long text into multiple
1|Microsoft E_] lines so you can see all of it.
A | c 2 :
Optimism at start (1(bad})- ¢
1 |Name Prison 10{good)) Optimis |f'~"|icr0s‘3”ct
2 |Alain Prost HMP Manchester 2 1| Excel 5
3 |AliaBhatt HMP Holloway 1 2
4 |Andre Agassi HMP Swansea 3
5 |Ben Okri HMP Manchester 5
6 |Boris Becker HMP Bristol 2 @ Tell me more
7 |Dave Robson HMP Pentonville 6 6
4 |David Attenbaroush HME Brictaol 3 3
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Sorting your data

12.Sorting (Single level)

Simple sorting can be done by highlighting the column you want to reorder and using the options available in
each column header.

AutoSave (@ Of Intro to Excel workbook & exercises = £ search (Alt+Q) Kate White (‘, O | - a X
. . gta  Review  View Help  Acrobat 7 Comments 2 Share
Highlight the column — @
| Queries & Connections sl v = E M 8= ER @ g8
you’d like to reorder m 07 e ' =8| 7 -
. Stocks Geography 5] | Z| Sort  Filter Texu What-If Forecast | Outline
’ A B Advanced | Columns £ * [ | Analysis v Shest -

Get & Transform Data Queries & Connections Data Types Sort & Data Tools Forecast ~

Bl ; f Sort AtoZ

Lowest to highest.

1 |Prison ’ Name : Wc;lfure session @ Tell me more 2. SEIeCt Sort A-Z or Z-A
2 |HMP Bristol Boris Becker Y 27 February 2017 depending on your desired
3 |HMP Bristol David Attenborough A 17 August 1998 Order.

4 |HMP Bristol Dilip Kumar Y 23 July 2013

5 |HMP Bristol Dilip Kumar N 23 July 2013 No musical experience

6 |HMP Bristol Lionel Ritchie Y 27 April 2007 Plays a musical instrument

7 |HMP Bristol Marcus Clarke ¥ 21 March 2003 No musical experience

8 |HMP Bronsefield Emma Barnett ¥ 17 August 1998 No musical experience

9 |HMP Bronsefield Jacina Ardern ¥ 02 June 2000 Plays a musical instrument
10 |HMP Bronsefield Margaret Atwood N 07 June 2015 Plays a musical instrument

11 |HMP Bronzefield Diane Kruger Y 21 March 2003 No musical experience

A Sort Warning dialogue box should pop up, checking that you want to reorder the rows in full, rather than
just that column in isolation.

? X

Microsoft Excel found data next to your selection. Since you have not selected this data, it
will not be sorted.

What do you want to do? Keep the Expand the
(®) Expand the selection selection selected and
O Continue with the current selection click Sort.

Sort... Cancel

13.Quick Count view

A B c D E 7 =

1 Prison Name Welfare session Sentence start Musical experience

2 |HMP Bristol Boris y 2017 Plays a musical instrument

3 |HMP Bristol Davi . 998 Plays a musical instrument

4 |HMP Bristol Dilip SeleCt ara nge Of Cel IS and qUICkIy 13 No musical experience

5 |HMP Bristol Dilip view a Count Of the nu mber at 13 No musical experience

& |HMP Bristol Lione| . 07 Plays a musical instrument

7 |HMP Bristol Marc| the bOttom rlght Of your screen 003 No musical experience

8 HMP Bronsefield @|m 998 No musical experience

9 HMP Bronsefield Jacina Ardern Plays a musical instrument

10 HMP Bronsefield Margaret Atwood Plays a musical instrument

11 HMP Bronzefield Diane Kruger Y No musical experience

12 HMP Bronzefield Enid Blyton Y No musical experience

13 HMP Bronzefield Fiona Bruce Y Plays a musical instrument

14 HMP Bronzefield Freya Crew Y Plays a musical instrument
N 16 HMP Bronzefield Harper Lee Y 04 April 2009 s a musical instrument [+
3« ... Sheet1  Mentors | Attendance | Topic1exercise = Topic 2 exercise | Topic 3 exercise | Topic4 excercise | Answers ® < » 9

=3 Ready counte | HH M -—a—+ 10

EAN
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14.Sorting (Multi-level)

More complex sorting options are available via the Home tab

P Search (Al+Q)

1. Click on the Sort option

1 Comments 5 Share

i i i AR =g & 8=
2. This window will open. Select the column you want al Y GH - BB E2
to Sort by, the value to sort by and the sort order for RS o anced | ot 55 & A:“;;’;;;‘, Forecast
the ﬂrSt Ievel of SOfting. Sort & Filter Data Tools Forecast ~
A Sort ? X E F D
1 |Prison Name T acdtovet || X Delete provmg | My ot s beaders Musical experience
2 |HMP Bristol Boris E ol conon order Plays a musical insfrument
3 |HMP Bristol David | |sortby  prison ~ | | cell Values v [Awz ~ | | Plays a musical insgrument
4 |HMP Bristol Dilip Ki No musical experience
5 |HMP Bristol Dilip K No musical experience
6 |HMP Bristol Lionel Plays a musical instrument
7 |HMP Bristol Marcu No musical experiehce
8 |HMP Bronsefield Emma ' No musical experience
9 |HMP Bronsefield Jacing coneel Plays a musical insgrument
10 |HMP Bronsefield Margaret Atwood N 07 June 2015 .Pluys a musical instfrument
11 |HMP Bronzefield Diane Kruger Y 21 March 2003 No musical experience
Sort ? X
+ Add Level X Delete Level [E Copy Level Options... My data has headers
Column Sort On Ord
Sort by Cell Values v v
Name
Prison
Date of birth
Age now 3. If you only see Column A,
Date registered
Age at registration Column B etc in this list, click
Instrument experience
P My data has headers
Total hours
Points per hour
Column1
Sort ? X
—|— Add Level X Delete Level [B Copy Level ~ Options... My data has headers
Column Sort On Order
Sortby | prison Cell Values ~ | AtoZ w7
Thenby Name AtoZ ~

4. Click on + Add level to add a secondary sort level. For example,
here we are sorting by prison name and then by participant name.
L Take a moment to think through the logical order you are sorting on.

10
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Using Formula

15. Auto sum

Automatically add up a range of values to arrive at the Total.

Intro to Excel workbook & exercises P Search (Alt+Q) Kate White ’; i m = a X

1 Comments = Share

File Hoﬁ Insert Page Layout Formulas Data Review View Help Acrobat

D“j - E 5 27 O @

e |8 s L . O oLt fray

Clipboard & Font Alignment Number Styles Editing Analysis | Sensitivity ~
SUM - X« fr | =suM(czH2) v

A B c D E F H I J H

1 Date MM Supervisor HMP Holloway HMP Bristol HMP Pentonville HMP Bronzefleld H HMP swunsegmmm

2 Jan-17 Amina Hussain | 8 7 6 ly | B

3 Feb-17 Amina Hussain ' 7 8 5 umber2]

4 Mar-17 Amina Hussain 8 8 5

5 Mar-17 Amina Hussain 8 8 5

6 Apr-17 Amina Hussain 7 9 i

7 May-17 Aslf Kahn g 10 10

8 Jun-17 Asl

9 Jul-17 As 1. Click in the cell you want the Total to appear in (in this case 12)

10 Aug-17 Asl . Z .
T Sep-17 As and then select the AutoSum icon in the Home tab menu.

12| Oct-17As Check that the correct range of cells has been highlighted (in this
13 Nov-17 Jol . . .

w | Dec17do case C2:H2). You can extend this range by clicking on the corner
15 Jan-18 Jo of the highlighted section and dragging to include more cells.

» Introduct

16. Copying formula

Once a formula has been entered into a cell, instead of recreating this formula in a neighbouring cell, you
can ‘copy’ this formula to other cells so the equivalent calculation is made.

AutoSave Intro to Excel workbook & exercises + £ Search (Alt+Q) Kate White .f; \ m - a %

1 Comments = Share

File Hoﬁ Insert Page Layout Formulas Data Review View Help Acrobat
= . A & . . Hinsert ~ /O @
PEIHS - o : o o Co%na\ Fo%as CE'{ EDEIE‘E - ." Szoltv& Find & Analyze
- “|&- A~ BB % Y WA e Table~ Sylesv | [ElFomatY | €~ Fiore Seectv | Data
Clipboard [ Font & Alignment & Number ] Styles Cells Editing Analysis Sensitivity ~
12 - £ | =sum(cz:H2) v
A B & D E F G H I J H
1 Date MM Supervisor HMP Holloway HMP Bristol HMP Pentonville HMP Bronzefleld HMP Manchester HMP Swansea Total attendees
2 Jan-17 Amina Hussain 8 7 6 10 7 Ialj‘
3 Feb-17 Amina Hussaln 7 8 5 12 |
4 Mar-17 Amina Hussaln 8 8 5 12
5

Click on the cell containing the formula you’d like to copy. Hover
over the bottom right corner of the cell where you see the solid

square, until the cursor changes to a plus sign. Now click and drag 20
' down to copy the formula to cells below. Let go and the Total j :z

values will appear in these cells.

11
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AutoSave (8 2 Intro to Excel workbook & exercises ~ £ Search (Alt+Q) Kate White f\, caf = o x
File Home Insert Page Layout Formulas Data Review View Help Acrobat U Comments 15 Share
X v = — o i Einsert ~ | X~ A
tl“:l [ . = =B '?/“ (PJ General v E @ @ ED - _ Z? /O
Paste 5] =—===x= E % 9 %8 Conditional Formatas Cell Cort 81 Cimd @ | Aeabigp
v = ====|8 B % 30 Formatting v Table ¥ Styles - Down a
Clipboard [F] Font F1 Alignment [F] Number [~] Cells | R\ghl sis Sensitivity ~
12 - fr | =sum(C2:H2) Up ~
A G A Leit J ﬁ
! |pate Alternatively, you can select the cell containing the [anchester Hw pdess
2 Jan-1 . . . 7 eries... 57
5| rebet formula and the neighbouring cells you’d like to copy s h
H . T . Justify
a| mar it too and then click on the Fill icon in the Home menu 5 g
| Mo and select the relevant direction. In this case Down. ° 2w
6 Apr-1 5 16
7 May-17 = = = 4 18
8 Jun-17 Aslf Kahn 10 8 3 12 3 19
17.Average

Similar to AutoSum, the Average function will automatically calculate the average for a range of values.

AutoSave (8 Intro to Excel workbook & exercises + £ Search (Al+Q) Kate White f;; 2] = a X
File Hoﬁ Insert Page Layout Formulas Data Review View Help Acrobat - Comments |5 Share
ﬁ":l X Poppins 11 A A B | General . 1= @ Ej %'[;‘9: “v 2xAw (O
e wIu-E- oA D R
Clipboard & Font ] Alignment ™ Number m Styles nalysis | Sensitivity ~
Count Numbers
140 ke o v
A B c D E Min I g [+
1 Date MM Supervisor HMP Holloway HMP Bristol HMP Penton MP Manchester HN M-m I itendees
25 Mar-19 M i 1 6 " 44
30 Apr-19 7 18 63
3 May-10 As with AutoSum, select the cell where you want the 8 0 55
32 Jun-19 Average value to be calculated and then click on the 5 19 60
:i ;:g'_:: down arrow next to the Auto Sum icon and select : :: ::
35 Aug-19 Average. 5 19 60
36 Sep-19 4 17 54
37 Oct-19 Deepak Patel 9 8 14 12 3 18 64
38 Nov-19 Deepak Patel 8 9 13 13 4 17 64
39 Dec-19 Deepak Patel 9 10 14 14 3 20 70
o —
1

18. Adding a simple multiplication

When adding a formula to calculate a multiplication, first enter the = equals sign. Then instead of typing in
the values, select the cell containing the first value; add the * sign (Shift key and number 8 key), and then
select the cell containing the second value. Then click Enter.

12 S X v f| =H2*2
G D E F G H | J K L -]
1 HMP Holloway  HMP Bristol ~ HMP Pentonville HMP Bronzefield HMP Mancheste HMP Swansea  Expenses unit cost Total cost
2 | 3 4 4 5 2 5 £250{=H2"12
3 3 4 4 4 1 5
4 3 4 4 3 1 5

12
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Printing

In the print preview screen you can review your data before printing it.

Music Mentors data with notes & - Saving... Alice Linelt o (&, = I -

Print
EE’.J Copies: |1 .

Home

Print
" Difference  Target met?
Alain Prost HMP Manchester 2 3D 1 Target not met
: Alla Bhatt HMP Holloway 1 1 0 Target not met
Printer Andre Agass! HMP Swansea 3 T 4 Target met
Microsoft Print to PDF Ben Okri HMP Manchester 5 L) 4 Target met
2B s = Boris Becker HMP Br 35 1 Target not et
Ready
Dave Robson HMP ] 0 Target not met
Printer Properties David Attenborough ~ HMP . . N [ 0 Target not met
_ meman  wef Make sure the orientation is PR R
Settings Diane Kruger 3 -2 Target not met
P e res Diego Maradonna correct for the data set 1 4 Tager et _
Only print the active sheets ¥ 0 Targst not met
- - L ) 5 Target met
Pages -/t HMP Swansea 5 X 3 Target mat
Collated . HMP Bronzefield = met
123 123 123 Fiona Bruce HMP Holloway at
Fiona Bruce HMP Holloway . . t
[ unsopeoiemsion < FreysCrew HUP Bromefeld Scaling allows you to neatly fit |«
Harper Lee HMP Bronzefield t
Hone Heke HMP Pentonville et
o~ . e all columns and / or rows on ;
21cm ¢ Jack Tate HMP Manch:
Jane Goodall t
Normal Margins one age
E Top: 1.91 cm Bottom: 1.91 ¢ p g et
ansea
[ MNoScaling Ioan Chen HMP Bronzefield 3 - y ot
TO  Pprint sheets at their actual size lohn Cleese HMP Pentonville E] A% 1 Target not met
John Steinbeck HMP Pentonville 1 2 1 Target not met
Eage Setup John Steinbeck 2D 1 Target nat met
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